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Notice 
 
Philips Electronics North America [Corporation] shall not be liable for technical or editorial 
errors or omissions contained herein. The information in this guide is subject to change without 
notice © 2001 Philips.  
 
Except for use in connection with the accompanying Philips product, no part of this guide may 
be photocopied or reproduced in any form without prior written consent from Philips. Philips 
and the Philips logo are trademarks of Philips Electronics North America. 
 
Microsoft, Windows, Windows NT, and other names of Microsoft products referenced herein 
are trademarks or registered trademarks of Microsoft Corporation. All other product names 
mentioned herein may be trademarks or registered trademarks of their respective companies.  
 
Printed in U.S.A. This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions. (1) This device may not cause harmful interference and (2) this 
device must accept any interference received, including interference that causes undesired 
operation. The following words and symbols mark special messages throughout this guide: 
 
 
Ø WARNING: Text set off in this manner indicates that failure to follow directions could 

result in bodily harm or loss of life. 
 
 
 
 
Ø CAUTION: Text set off in this manner indicates that failure to follow directions could 

result in damage to equipment or loss of information. 
 
 
 
 
 
 
Ø WARNING: The radiated output power of Bluetooth CF Card is far below the FCC radio 

frequency exposure limits. Nevertheless, the Bluetooth CF Card shall be used in such a 
manner that the potential for human contact during normal operation is minimized. 

 
 
 
 
User’s Guide 
Bluetooth Compact Flash Card  
First Edition (September 2001) 
Philips Electronics NA. 
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1 Getting Started 

 
1.1 Introduction 
 
Bluetooth wireless technology provides fast, reliable, and secure wireless communication in a 
small space, and enables you to synchronize your handheld PC with your desktop computer. 
Bluetooth wireless technology eliminates the need for cables between electronic devices such as 
desktop computers, printers and local area networks (LANs). 

1.1.1 Terminology 
 
Before you install and start using your new Bluetooth Compact Flash Card, please take a few 
minutes to review some of the terms that you will be seeing throughout the document. 
 
§ Authentication: Security feature that requires users to verify a numeric passkey before 

exchanging data. 
 

§ Authorization: Security feature that requires user approval before another user is allowed to 
share data. 
 

§ Bluetooth Neighborhood: Collection of Bluetooth devices. 
 
§ Bonded Device: Recognized by your device so as not to require Authentication or 

Authorization. 
 
§ Device: Bluetooth enabled device. 
 
§ Device address: Unique electronic address of a Bluetooth device. 
 
§ Device discovery: The location and recognition of one Bluetooth device by another. 
 
§ Device group: Compilation of several Bluetooth devices into a group, normally to conduct 

related tasks. 
 
§ Device name: Name that a Bluetooth device provides when discovered by another device. 
 
§ PIM: Personal Information Manager. Applications used to manage everyday business 

functions (for example, Contacts, Calendars, and Tasks). 
 
§ Service Discovery: Determines which applications other devices have in common with 

yours. 
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1.1.2 Supported Profiles 
 
The services supported by your Bluetooth CF Card are defined as “Profiles”. Available Profiles 
include: 
§ Generic Access 
§ Service Discovery 
§ Serial Port 
§ LAN Access 
§ Dial-Up Networking 
§ Generic Object Exchange 
§ Object Push 
§ File Transfer 
§ Synchronization 
 
Without the need of any cables or wiring, you can: 
q Transfer files 
q Access Dial-up networks 
q Connect to local area networks 
q Perform an ActiveSync session 
q Connect to serial ports 
q Exchange PIM data 
q Send or exchange business cards 
 
The basic functions of the Bluetooth Neighborhood include: 
§ Device Discovery 
§ Service Discovery 
§ Establishing links with remote devices 
 

1.2 Installing the Software 
 
This section contains instructions for installing the software required to use your new Bluetooth 
Compact Flash Card on a Handheld PC. 
 
1. Remove any accessory from your Handheld PC. 
 
2. Place the Handheld PC in its cradle and make an ActiveSync connection to your desktop or 

notebook computer. 
 

3. Insert the Bluetooth Compact Flash Card installation CD into the CD tray of your desktop or 
notebook computer. 

 
4. From the Windows Start menu on your base computer, select start --> Run, and type in x: 

Setup.exe  (where x equals the letter of the CD-ROM drive) or browse to the Setup.exe file, 
then click OK. 

 
5. Follow the on-screen instructions. 
 

§ If you are prompted to uninstall files, follow the on-screen instructions. Once the 
uninstall is finished, begin again with step number one of this procedure. 
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6. If you cannot successfully load the application, then perform a factory reset of the Handheld 

PC. Refer to the Handheld PC user guide for more information on performing factory reset 
of the Handheld PC. 

 
§ Ensure that your desktop or notebook computer and Handheld PC have completed all 

operations before exiting the setup. 
 
7. When the install program is finished, remove the Handheld PC from its cradle and conduct a 

soft  reboot by inserting the stylus in the hole in the bottom of the Handheld PC. Refer to the  
Handheld PC user guide for more information on rebooting the Handheld PC. 

 
8. Insert the Bluetooth Compact Flash Card into the Handheld PC (See “Figure 1.1: Inserting 

Compact Flash Card.”). A new icon (the Bluetooth Radio con) should display at the bottom 
of the “Today” screen and the LED at the top of the Compact Flash Card should blink. 

 

 
Figure 1.1: Inserting Compact Flash Card. 

 
§ The Bluetooth Radio icon is initially dark when the Handheld PC is inserted into the 

Wireless Pack and becomes brighter when it recognizes the software. 
 

1.3 Un-installing the Software 
 
This section contains instructions for un-installing the software required to use your Handheld 
PC Bluetooth Compact Flash Card. 
 
1. If inserted, remove the Bluetooth Compact Flash Card from your Handheld PC. 
 
2. Place the Handheld PC in its cradle and make an ActiveSync connection to your desktop or 

notebook computer. 
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3. Insert the Bluetooth Compact Flash Card installation CD into the CD tray of your desktop or 

notebook computer. 
 
4. From the Windows Start menu on your base computer, select Start --> Run, and type in 

x:Setup.exe (where x equals the letter of the CD-ROM drive) or browse to the Setup.exe 
file, then click OK. 
 

5. Follow the on-screen instructions. When requested if you would like the wizard to un-install 
the Bluetooth device, select “Yes” and then click on “Next”. 

 
6. Follow the on-screen instructions. 
 

1.4 Launching the Application 
 
The Bluetooth application is launched from the Handheld PC Today Screen. Select “Bluetooth 
Manager” either from the Start Menu (See “Figure 1-2: Launching the Bluetooth Manager from 
the Start Menu”) or from the Bluetooth Radio menu (See “Figure 1-3: Launching the Bluetooth 
Manager from the Bluetooth Radio Menu Icon”). Access the Bluetooth Radio menu by tapping 
on the Bluetooth Radio icon at the bottom of the Today Screen. 
 
 

Figure 1-2: Launching the Bluetooth Manager from the Start Menu 
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Figure 1.3: Launching Bluetooth Manager from Bluetooth Radio Icon Menu 
 
If you have no devices saved to your Handheld PC, a dialog box will prompt you to search for 
Bluetooth devices (See “Figure 1-4: Initial Search Prompt”). 
 
§ Choose “Yes” to display the Search screen and the Bluetooth Compact Flash Card begins 

searching for Bluetooth devices in the area. 
 

§ Choose “No” to jump to the main window without conducting any search. 
 
§ Choose “Yes” to initiate a search. 
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Figure 1-4: Initial Search Prompt 
 
When the search is complete, the screen displays all devices that were found (See “Figure 1-5: 
Search Screen”). 
 

 
Figure 1-5: Search Screen 
 
You will now want to assign these devices to a Device Group. For information on Device 
Groups (see Chapter 3, “Device Groups”). 
For now: 
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1. Select those devices that you want to keep by selecting the individual check boxes. 
 
2. Tap “Save.” The Device groups screen will appear (See “Figure 1-6: Device Groups.”). 
 

§ Only “All Devices, Home and Work” appear until you add other groups to the list (see 
the section in Chapter 3, “Modifying Groups”). The “All Devices” group is 
automatically checked and always dimmed; it cannot be unchecked. 

 
3. Tap “Ok” to save selected device(s) to the selected group(s) and to return to the Search 

screen. 
 
4. Repeat for additional devices and/or groups. 
 
5. Tap “Ok” to return to the main window. 

 
 
Figure 1-6: Device Groups 
 

1.5 The Main Window 
 
Following this initial device discovery session, the main window appears (See “Figure 1-7: Main 
Window Controls.”) listing saved Bluetooth devices. Following your initial search, it displays 
“All Devices.” 
 
§ The main window shows discovered devices, yet does not necessarily show all available 

devices within range.  For the devices that have been discovered there is an indication in the 
status category of which one (s) are currently within range. 
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Figure 1-7: Main Window Controls 
 

1.5.1 Device Group Drop Down Menu 
 
The Device Group Drop Down Menu allows you to display devices found in a particular device 
group or in all groups (“All Devices”). This drop down menu also includes a selection for 
Adding, Editing, or Deleting a group (see the section in Chapter 3, “Modifying Groups”). 
 

1.5.2 Device List 
 
The Device List displays those devices (for example, other Handheld PC’s, laptops, etc.) 
recognized by your Handheld PC. The availability of each device is displayed in the status 
column of the list view or indicated by the display of the icon. 
 

1.5.3 View Menu 
 
The View Menu allows you to toggle your view of devices from Icons to List format. This menu 
also allows you to refresh the status of devices being viewed (see the section in Chapter 2, 
“Viewing Devices”). 
 

1.5.4 Tools Menu 
 
The Tools Menu allows access to dialog screens for group settings (see the section in Chapter 3, 
“Group Settings”) and system diagnostics (see Chapter 4, “System Diagnostics”). 
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1.5.5 Search 

 
Tapping Search launches the Search screen (see the section in Chapter 2, “The Search Screen”). 

1.5.6 Bluetooth Radio Icon 
 
Once the Bluetooth application has been started, you can view the Bluetooth Radio Icon at the 
bottom of the Today screen (See “Figure 1.8: Today Screen.”) or at the bottom of the main 
Bluetooth Main Window (See “Figure 1.9: Bluetooth Main Window.”). 
 

 
Figure 1.8: Today Screen 
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Figure 1.9:  Bluetooth Main Window 
 
From the bottom of the Today Screen you can: 
 
§ Check to be certain that the radio was on initially. 
 
§ Turn the Radio On or Off—Select to toggle the radio. 
 
§ Launch the Bluetooth Manager application. 
 
§ Initiate a wireless ActiveSync session (see the section in Chapter 2, “Perform an ActiveSync 

session”). 
 
§ View the current status of the Radio and current connections 

(See “Figure 1-10: Radio Status.”). 
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Figure 1-10: Radio Status 
 
Tap-and-hold any device in the current connections list of the “Current Status” window to open 
a menu that allows you to close the connection. 
§ Obtain version information “About” the Bluetooth Manager. 
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2 Device Discovery 

2.1 The Search Screen 
 
The search screen (See “Figure 2-1: Search Screen.”) allows you to search for devices and 
assign them to device groups. To open the search screen, tap “Search” at the bottom of the main 
window. The Bluetooth Compact Flash Card will automatically begin searching for Bluetooth 
devices. When it finishes searching, the screen displays a device list. 
 

Figure 2-1: Search Screen 
 

2.1.1 Device List 
 
Presented in tabular format, the device list displays devices found during the search. The list can  
be sorted by either Device Name or Type by tapping the respective header. 
 
1. A checkbox is provided to allow selection of individual or multiple devices for saving to 

groups. 
 
2. The “New” column will be marked with an asterisk “*” if the found device is not already 

saved. 
 
§ Search button—Launches the search for devices (see the section in this chapter, 

“Searching for Devices”). 
§ Save button—Allows you to save devices to device groups (see the section in this 

chapter, “Saving Devices”). 
 

§ Filter button—Launches the search filter screen (See “Figure 2-2: Search Filter.”). 
Allows you to tailor your search to specific devices. “Find all devices” is initially 
selected by default. This screen also allows you to specify the duration of a search. 
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Ø If “Stop searching after” is left unchecked, searches will continue until you terminate the 

search by tapping “Stop.” 
 
 

§ Search Status Line—Text string located at the bottom of the search screen that displays 
the status of the search. This status line also tells you how many devices were found 
during the search. 

 
Figure 2-2: Search Filter 
 

2.2 Searching for Devices 
 
Your initial search was conducted when you first launched the application (see the section in 
Chapter 1, “Getting Started”).  It is always possible to conduct a new search for Bluetooth 
devices.  
 
1. At the bottom of the main window, tap “Search.” The search  screen appears (See  

“Figure 2-1: Search Screen.”) and the Bluetooth Compact Flash Card begins to search for 
Bluetooth devices in the area. The devices appear on the screen as they are found (See 
“Figure 2-3: Searching for Bluetooth Devices.”). 
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§ The “Search” button changes to “Stop” while the search is in progress and changes back 
to “Search” when the search is complete (times out) or when you tap “Stop.” 

 
Figure 2-3: Searching for Bluetooth Devices 
 

2.2.1 Saving Devices 
 
Once a device is discovered and you decide that you want to save it for future use, it should be 
saved to a Device group. The procedure is identical to that used when you conducted your 
initial search except that you may now have more Device groups to choose from. 
 
1. From the Search Screen, select those devices that you want to keep by tapping the respective 

checkboxes. 
 
2. Tap “Save.” The Device groups screen appears (See “Figure 2-4: Device Groups.”). 
 
3. Check the box next to any of the groups that you want to save these devices to. 
 

§ You can check one or several groups. You can modify the groups prior to making your 
selection by tapping the “Add Group” button (see the section in Chapter 3, “Modifying 
Groups”). 

 
4. Tap “Ok” to save the devices to the indicated groups and return to the Search screen. 
 
5. Repeat for additional devices. 
 

§ Whenever you save a device to any group, it is also saved to the “All Devices” group. 
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Figure 2-4: Device Groups 

2.2.2 Device Information Dialog 
 
Access the Device Information Dialog from the main window by tapping a device (See  
“Figure 2-5: Device Information.”). 
 

 
Figure 2-5: Device Information 
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§ Device Name—Name assigned by owner of selected device. 
 
§ Device Address—Unique Bluetooth address used to identify the device. 
 
§ Device Type—Identifies the type of device (for example, PDA, cell phone, etc.) 
 
§ Device Bonded—Displays “Yes” if a bond has been established. Bonding allows the device 

to bypass authorization and authentication. A bond can be created or broken via the 
“Actions” menu located at the bottom of the Device Information screen. 

 
§ Last Seen—Indicates the last date and time the device was discovered near your device. 
 

§ ActiveSync Partner checkbox—Active only for laptop or desktop computers. Check this 
box to indicate that you wish to use this device as an ActiveSync partner. 

 
§ Show Device Groups—Tap here to review or specify which groups this device belongs to 

(see the section, “Moving and Removing Devices” in this chapter). 
 
§ Actions Menu—Allows you to initiate an action with the selected device (for example, send 

a business card) (see the section in this chapter, “Communicating With Other Devices”). 

2.2.3 Viewing Devices 
 
Devices can be viewed in two different formats, Icons and List.The “View” menu (See “Figure 
2-6: View Menu (Icon View).”) allows you to select either of these views. It also allows you to 
refresh the screen. 
 
 

 
Figure 2-6: View Menu (Icon View)  Figure 2-7: View Menu( List View) 
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§ Icon View (See “Figure 2-6: View Menu (Icon View).”) —Presents you with a graphical 

representation of the device (for example, Computer, Access Point, Cell Phone, etc.). The 
device name, assigned by the owner of the device, appears below the icon. 
 

§ List View (See “Figure 2-7: List View.”)—Provides the same information as the Icon View, 
only in tabular form. The left column displays the device name and type. The right column 
tells you the current status of the device (for example,Connected, Available, Unavailable). 

 
§ Refresh—Updates the status and availability of each displayed device. 

2.3 Communicating With Other Devices 
 
Once you have established contact with a device, you can exchange data. 
 
You can: 
§ Send a file. 
§ Send or exchange contacts, calendar, and tasks. 
§ Perform an ActiveSync session. 
§ Connect for DialUp or LAN access. 
§ Connect to serial port. 
§ Create or remove bonds. 
 
You can establish communication from the Main Window or the Device Information Dialog 
Window. 
 
From the Main Window: Tap-and-hold the device you want to communicate with; you are 
presented with a list of services that the selected device supports (See “Figure 2-8: 
Communicating with other devices.”). 
 
Or from the Device Information Dialog Window: Select the “Actions” menu (See “Figure 2-9: 
The Actions Menu.”). 
 
 
 
Ø Services will only be displayed if the selected device is discoverable. 
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Figure 2-8: Communicating with other devices 
 

 
Figure 2-9: The Actions Menu 
 

2.3.1 Send File 
 
§ Allows you to send a file to another device. 
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1. Discover the available services of the device that you want to send a file to. 
 
 
Ø In the main window, tap and hold the device. In the device information dialog window, 

select   via the actions menu. 
 
 
2. Select “Send File.” The “Send a File” screen appears (See “Figure 2-10:  Send a File.”). 
 
 
 

 
Figure 2-10: Send a File 
 
3. Specify the file that you want to send by entering its location and name in the window or by 

selecting the file from the “Browse...” menu. 
4. Tap “Send” to transfer the file or “Cancel” to abort the operation. Transfer progress is 

displayed (See “Figure 2-11: Send a File (Transmitting).”). Send button is dimmed initially 
and it is enabled only when the user selects the file to be send. 
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Figure 2-11: Send a File (Transmitting) 

2.3.2 Send Business Card 
 
§ Allows you to send your business card information to another device. 

2.3.2.1 From Main Window 
 

1. Discover the available services of the device that you want to send a business card to. 
 
 
Ø In the main window, tap and hold the device. In the device information dialog window, 

select via the actions menu. 
 
 
2. Select “Send Business Card.” 
 
3. If you have not set up your business card information (see the section in Chapter 3, “PIM 

Objects”), you will be prompted to select a contact name from your contact database (See 
“Figure 2-12: Please select a Contact Name.”). Select a contact name and tap “Ok” or tap 
“Cancel” to set up your business card information. 
 
 

Ø Once you select a contact name for business card transfer, that contact will remain the 
default until it is changed  (see the section in Chapter 3, “PIM Objects”). 
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Figure 2-12: Please select a Contact Name 
 
 
 
 
Ø The success or failure of the transfer will be displayed. 
 
 

2.3.2.2 From the Contacts Dialog 
 
§ Business card can also be sent directly from the Contacts list. 
 
In the Start Menu, select Contacts. 
 
1. Tap  & Hold on the Contacts item which you want to send to other device (See “Figure 2.13: 

Contacts Dialog.”) or select the Contacts item & press Tools (See “Figure 2.14: Contacts 
Tools Menu.”). 

 
2. Select “Send Via Bluetooth”. A search dialog appears on the screen (See “Figure 2.15:  

Search Dialog.”). 
 

§ “Detail” Button in the Search Dialog gives the details of the transaction. 
§ “Refresh” Button in the Search Dialog refreshes the device list.  

 
3. Select the Device to which you want to send the Business card and press Send. 
 
 
Ø The success or failure of the transfer will be displayed for the current group. 
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Figure 2.13: Contacts Dialog        Figure 2.14: Contacts Tools Menu 
 

 
Figure 2.15:  Search Dialog 
 
 
 
Ø The above steps mentioned are true for Calendar & tasks also. 
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2.3.3 Exchange Business Card 
 
§ Allows you to exchange business card information with another device. This function works 

the same as when sending your business card with the exception that, if available, you will 
also receive the other device’s information directly into your contacts database. 

 

2.3.4 Connect to Serial Port 
 
§ Allows you to connect to another device’s virtual Bluetooth serial port to utilize certain 

applications and hardware. 

2.3.5 Connect for DialUp Access 
 
 
Ø When viewed on Handheld PC 2002, this menu item is titled “Set as Internet Dial-Up 

connection”. 
 
 
§ Allows you to connect wirelessly to Bluetooth equipped cell phones and modems. You will 

first be prompted to choose or create a dialup connection with basic dialing information (See 
“Figure 2-16: DialUp Information.”). Once connected to a device with dialup capability, you 
may be requested to provide additional information. Refer to the user guide that came with 
your Handheld PC for more information on DialUp connections. 

 

 
Figure 2-16: DialUp Information 
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2.3.6 Connect for LAN Access 
 
 
Ø When viewed on Handheld PC 2002, this menu item is titled “Set as internet LAN 

connection”. 
 
 
§ Allows you to connect to Bluetooth devices that are already participating in a Local Area 

Network (LAN). Once connected, you will be able to participate in the LAN for accessing 
services like Internet Access. 

 

2.3.7 Perform an ActiveSync session 
 
§ Allows you to connect to and automatically update information with a Bluetooth device that 

has been designated as an ActiveSync partner. 
 
1.    Setting up the Host computer. 
 
 
Ø Only a laptop or desktop computer (Host PC) can be designated as an ActiveSync partner. 
 
 
§ Using the serial or USB connection, manually establish an ActiveSync partnership as 

described in the user guide that came with your Handheld PC. 
 
 
Ø You can establish a partnership with more than one device; however, your device will 

initiate ActiveSync with the first partnered device that is discovered. 
 
 
§ Run the Bluetooth Configuration Utility on the Host PC to determine which COM Port is 

configured for local serial service. Refer to the Bluetooth user documentation that came 
with your host PC for information on running the configuration utility. 

 
§ Open the ActiveSync window on the Host PC. Select File/Connection Settings... and 

configure it only to monitor the COM Port identified in step 2 above. Disable USB and 
Ethernet. 
 

2.    Wireless ActiveSync 
 
§ Discover and save the Host PC to one or more of your Groups. 
 
§ Tap on the ActiveSync Host PC to display “Device Information” and check the “ActiveSync 

partner” checkbox (See “Figure 2-17: ActiveSync Partner.”). 
 
§ Initiate ActiveSync via the Bluetooth Radio icon located at the bottom of the Today screen. 
 
§ Follow on-screen instructions. 
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Figure 2-17: ActiveSync Partner 

2.3.8  Create bond with this device 
 
§ (Found only in the “Actions” menu)—Allows you to establish a bond with another device to 

allow uninterrupted exchange of data. 
 

1. Tap on the device that you want to bond with to display the device information dialog. 
 
2. Select “Create bond with this device” from the “Actions” menu. A screen will appear asking 

you to enter a PIN code (See “Figure 2-15: PINCODE REQUESTED.”). 
 

Figure 2-18: PINCODE REQUESTED 
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3. Enter the PIN code that you and the owner of the selected device have agreed to. 
 
4. Tap “Ok.” The owner of the selected device will be prompted to enter the same PIN code. 
 
A status screen will appear indicating the success of the bond. 
 

2.3.9  Remove bond with device 
 
§ (Found only in the “Actions” menu)—Allows you to remove a bond. 
 
1. Tap on the device that you want to remove the bond to display the device information 

dialog. 
 
2. Select “Remove bond with device” from the actions menu. 
 
 

2.3.10  Remove this device 
 
§ Allows you to remove a device from your database of discovered devices. 
 
1. Tap on the device that you want to remove to display the device information dialog. 
 
2. Select “Remove this device” from the actions menu. 
 
 
Ø A dialog prompts you to confirm your action. 
 
 
You are returned to the main window. The selected device no longer exists in any of your  
groups. 

2.4 Moving and Removing Devices 
 
You can move a device between or remove a device from any group except “All Devices.” 
 
 
Ø You can only remove a device from “All Devices” by removing the device from your 

database (see “Remove this device” in this chapter). 
 
 
1. Tap on the device to display the Device Information window (See “Figure 2-5: Device 

Information.”). 
 
2. Tap the “Show Device Groups” button to display the Device Groups screen (See “Figure 2-

4: Device Groups.”) 
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3. Check those groups where you want the device to appear and uncheck those where you do 
not. 

 

3 Device Groups 
 
Three empty device groups named “All Devices,” “Home,” and “Work” are provided when you 
install the Bluetooth software. All discovered Bluetooth devices are stored in the “All Devices” 
group when saved. “All Devices” cannot be renamed or deleted. 
 

3.1 Modifying Groups 
It is possible to Add, Rename or Delete items on your Group List.From the main window, select 
“Add/Rename/Delete” from the Group List Pull Down (See “Figure 3-1: Modifying Groups.”). 
 
 

 
Figure 3-1: Modifying Groups 
 
Or from the “Device Information” screen, tap the “Show Device Groups” button and then the 
“Add Group” button. 
 
The “Edit Device Groups” screen appears (See “Figure 3-3: Edit Device Groups.”), displaying 
all current Device Groups. 
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Figure 3-3: Edit Device Groups 
 
To Add a Group: 
 
1. Tap the “Add” button. Another group titled “New Group” is appended to the list. 
 
2. Select the “New Group” text and type in the desired group name. 
 
3. Tap the return key. 
 
To Rename a Group: 
 
1. Select the text of the group you want to rename and tap the “Rename” button. 
 
2. Type in the desired group name. 
 
3. Tap the return key. 
 
To Delete a Group: 
 
1. Select the group you want to delete. 
 
2. Tap the “Delete” button. 
 
 
Ø A dialog prompts you to confirm your action. 
 
 

3. Tap “Yes” to delete the group or “No” to abort. 
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3.2 Group Settings 
 
Access Group Settings by selecting “Settings for <group>” from the “Tools” menu in the main 
window (See “Figure 3-4: Selecting Settings for <group>.”). 
 

 
Figure 3-4: Selecting “Settings for <group>” 
 
These settings provide the group certain information about your device, as well as specify how it 
interacts with the rest of the group. The group settings are distributed among six different tabs 
 
(See Figure 3-5: General Tab.”). You can change the group that you are modifying from any tab. 
Shifting groups or tabs automatically saves data. 
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3.2.1 General Tab 
 

 
Figure 3-5: General Tab 
 
§ Device Name—This is the name that other Bluetooth device users see when they discover to 

your device. 
 
§ Default Passkey (Blank by default)—Used for authenticating connections requested by 

other devices for transactions that need a “Passkey” (see other service tabs for passkey 
requirements). The other user must know your passkey to complete the transaction. If left 
blank, you will be requested to enter a passkey every time that one is required. 

 
§ Delete inactive devices-- (Found only under “All Devices”) Determines how long any 

device remains in the group between discoveries. You can specify the number of days 
Device Groups that the system uses (the default is 30 days). If the checkbox is left 
unchecked, devices are never automatically deleted from the group. 
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3.2.2 Connections Tab 
 

 
 
Figure 3-6: Connections Tab 
 
§ Let other devices see me (Checked by default)—Check this box to allow other devices to 

locate your device in a search. 
 
 
Ø This will not prevent devices that have previously discovered your device from conducting a 

transaction since they already know your Bluetooth address. 
 
 
§ Let other devices connect to me (Checked by default) —Check this box to allow other 

devices to connect and conduct transactions. If unchecked, no other device can initiate a 
connection with your device. 

 
 
Ø This checkbox has no affect on outgoing connection requests. 
 
 
§ Use the “Choose devices...” dialog (See “Figure 3-7: Choose Devices.”) to specify what 

kind of devices you want to allow to connect to your device. 
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Figure 3-7: Choose devices Dialog 
 
§ Transmission power for this group—Allows you to choose the transmission power level 

that is used whenever the group is selected. Selection of this power level determines the 
transmission range (and therefore power consumption) of your device. 

3.2.3 File Sharing Tab 

 
Figure 3-8: File Sharing Tab 
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§ Let other devices use this service (Checked by default) —Check this box to allow other 
devices to connect for file sharing. If unchecked, you can still connect with other devices 
and send them files. 

 
§ Authorization required (Checked by default)—Check this box if you want to screen any 

unbonded devices prior to allowing a transaction. If checked, you will be prompted to 
“accept” or “reject” transactions by any unbonded devices (See “Figure 3-9: Authorization 
Dialog.”). 

 
§ Passkey is required (Unchecked by default)—Check this box to require authentication for 

file sharing. If checked, you will be prompted to “accept” or “reject” transactions by any 
unbonded devices (See “Figure 3-10: Passkey Required.”).  Unbonded devices will be 
required to supply a matching passkey. 

 

 
Figure 3-9: Authorization Dialog 
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Figure 3-10: Passkey Required Dialog 
 
§ Encryption is required—Enabled only when you check “Passkey is required.” Check this 

box to enable data encryption when transmitting data. 
 
§ Shared Directory—Displays the name and the path of the folder used to store files received 

from other devices. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.2.4  
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3.2.5 PIM Objects Tab 
 

 
Figure 3-11: PIM Objects Tab 
 
§ Let other devices use this service (Checked by default)—Check this box to allow other 

devices to connect for transferring PIM objects. If unchecked, you can still connect with 
other devices and send them files. 

 
§ Authorization required (Checked by default)—Check this box if you want to screen any 

unbonded devices prior to allowing a transaction. If checked, you will be prompted to 
“accept” or “reject” transactions by any unbonded devices (See “Figure 3-9: Authorization 
Dialog.”). 

 
§ Passkey is required (Unchecked by default)—Check this box to require authentication for 

transferring PIM objects. If checked, you will be prompted to “accept” or “reject” 
transactions by any unbonded devices (See “Figure 3-10: Passkey Required.”). Unbonded 
devices will be required to supply a matching passkey. 

 
§ Encryption is required—Enabled only when you check “Passkey is required.” Check this 

box to enable data encryption when transmitting data. 
 
§ Send my business card on request—Allows other devices that are able to connect to “Pull” 

your business card information. 
 
§ Accept all PIM objects sent to me—Allows other devices that are able to connect to send 

you PIM objects. 
 
§ Use this contact for my business card—Displays the name being used when you transfer a 

business card to other Bluetooth devices. The “Browse” button allows you to change 
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business card information by selecting from the full list of contacts in your Pocket Outlook 
database. If an Outlook contact is not available, then the data found in “My Information” of 
the device is used to form contact information. If the user deletes the contact entry, a runtime 
message appears the next time you attempt to send a business card. 

 

3.2.6 Serial Port Tab 

 
Figure 3-12: Serial Port Tab 
 
§ Let other devices use this service (Checked by default) —Check this box to allow other 

devices connect via the serial port. If unchecked, you can still connect with other devices. 
 
§ Authorization required (Checked by default)—Check this box if you want to screen any 

unbonded devices prior to allowing a connection via the serial port. If checked, you will 
be prompted to “accept” or “reject” transactions by any unbonded devices (See “Figure 3-9: 
“Authorization Dialog.”). 

 
§ Passkey is required (Unchecked by default)—Check this box to require authentication for 

connections via the serial port. If checked, you will be prompted to “accept” or “reject” 
transactions by any unbonded devices (See “Figure 3-10: Passkey Required.”). Unbonded 
devices will be required to supply a matching passkey. 

 
§ Encryption is required—Enabled only when you check “Passkey is required.” Check this 

box to enable data encryption when transmitting data. 
 
§ COM ports—Identify the virtual COM (Communications) ports associated with a Bluetooth 

serial port connection. The Inbound COM port is used when other devices initiate a serial 
connection to the  Bluetooth Compact Flash Card. The Outbound COM port is used when 
you initiate a serial connection to other devices. 



 
Bluetooth Compact Flash Card                                                                    Page 41 of 51  

3.2.7 DialUp Tab 
 

 
Figure 3-13: DialUp Tab 
 
§ Passkey is required (Unchecked by default)—Check this box to require authentication for 

connections via Dialup. If checked, you will be prompted to “accept” or “reject” transactions 
by any unbonded devices (See “Figure 3-10: Passkey Required.”). Unbonded devices will be 
required to supply a matching passkey. 

 
§ Encryption is required—Enabled only when you check “Passkey is required.” Check this 

box to enable data encryption when transmitting data. 
 
§ Using COM Port—Identifies the virtual BTC (Bluetooth Communications) port that will be 

used when you initiate a Dialup connection with another device. 
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4 System Diagnostics 
 
You can conduct basic checks of the hardware utilizing either the Loopback Test or the Reset 
BC01 Test. Both can be accessed via the Diagnostics screen. 
 

4.1 Loopback Test 
 

 
Ø If you select to run the Loopback Test or any other diagnostic test, the Handheld PC will soft 

reset. 
 
 
§ Tests the way that your device internally processes data.  
 
1. Select “Diagnostics” from the Tools menu at the bottom of the main window (See  

“Figure 4-1: Tools Menu.”). 
 

 
Figure 4-1: Tools Menu 
 
2. Select “Local Loopback Test” from the pull down menu and tap the “Run” button (See  

“Figure 4-2: Local Loopback Test.”). 
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Figure 4-2: Local Loopback Test 
 
The Diagnostics screen will display the result of the test (Pass or Fail). 
 

4.2 Reset BC01 Test 
 
§ Re-initializes (resets) the radio circuitry used to transmit and receive data. 
 
1. Select “Diagnostics” from the Tools menu at the bottom of the main window (See  

“Figure 4-1: Tools Menu.”). 
 
2. Select “Reset BC01 Test” from the pull down menu and tap the “Run” button (See  

“Figure 4-3: Reset BC01 Test.”). 
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Figure 4-3: Reset BC01 Test 
 
The Diagnostics screen will display the result of the test (Pass or Fail). 
 

4.3 Versions 
 
§ Version information about your device’s Hardware, Firmware and Software can be viewed 

by tapping on the “Versions” tab at the bottom of the Diagnostics screen (See “Figure 4-4: 
Versions.”). 
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Figure 4-4: Versions 
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5 Appendix - A 

5.1 Troubleshooting 

 
Symptom Possible Remedy 

 
The Application fails to install 
Properly. 

§ Make sure that you have uninstalled any existing 
Bluetooth software. If necessary, conduct a factory 
reset of the Handheld PC. 

 

Bluetooth Radio Icon does not appear in the Today’s 
Screen 

§ Make sure that you have inserted the CF card 
properly. 

I cannot discover other devices.  
 

§ Try moving closer to a known device. 
 
§ Check to make sure your radio is Turned ‘ON’ (see 

the section in Chapter 1, “Bluetooth Radio Icon”). 
 
§ Check to make sure you have not limited your 

ability to see devices via the Search Filter (see the 
section in Chapter 2, “Device List”). 

 
My range seems to be degraded in 
Certain groups. 
 
 

§ Check to ensure you have not restricted the 
transmission power, (see the section in Chapter 3, 
“Connections Tab”). 

Other devices cannot discover my 
Device. 
 

§ Try moving closer to a known device. 
 
§ Check to make sure your radio is turned ‘ON’ (see 

the section in Chapter 1, “Bluetooth Radio Icon”). 
 
§ Check to make sure you have not restricted other 

devices from discovering yours (see the section in 
Chapter 3, “Connections Tab”). 

 
Other devices can discover my device, but they cannot 
connect. 
 

§ Check to make sure you have not restricted other 
devices from connecting (see the sections in Chapter 
3, “Connections Tab”, “File Sharing Tab”, “PIM 
Objects Tab” and “Serial Port Tab”). 
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Symptom Possible Remedy 

Other devices do not receive my  correct business card 
information. 
 

§ Make certain that you have properly set up your 
business card information, (see the section in 
Chapter 3, “PIM Objects Tab”). 

 
I saved a device, or devices, to a group; but now I 
cannot find them. 
 

§ Check to see if they may have expired, (see the 
section in Chapter 3, “General Tab”). 

 

My device will not automatically stop searching. 
 

§ Check to make sure you have selected a search 
period (see the section in Chapter 2, “Device List”). 

 

My device is always prompting me to supply a 
password. 
 
 

§ Check your passkey settings, (see the sections in 
Chapter 3, “File Sharing Tab”, “PIM Objects Tab”, 
“Serial Port Tab” and “DialUp Tab”). 

My device will not let me delete the “All Devices” 
group. 
 

§ The “All Devices” group can not be renamed or 
deleted. 

 

I cannot conduct certain transactions with one device 
that I can perform with another. 
 

§ Not all devices offer the same Bluetooth profiles. 
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6 Appendix -B 

6.1 Agency Requirements 

6.1.1 Federal Communications Commission Notice 
 

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more of 
the following measures: 
 
§ Reorient or relocate the receiving antenna. 
 
§ Increase the separation between the equipment and receiver. 
 
§ Connect the equipment into an outlet on a circuit different 

from that to which the receiver is connected. 
 

§ Consult the dealer or an experienced radio or television 
technician for help. 
 

6.1.1.1 Modifications 
 
The FCC requires the user to be notified that any changes or modifications made to this device 
that are not expressly approved by Philips Electronics NA may void the user's authority 
to operate the equipment. 
 

6.1.1.2 Cables 
 
Connections to this device must be made with shielded cables with metallic RFI/EMI connector hoods in 
order to maintain compliance with FCC Rules and Regulations. 
 

6.2 Declaration of Conformity for products marked with the FCC logo - 
United States only 

 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation. 
 
For questions regarding your product, contact: 
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Philips Silicon Valley Centre 
Xxxxxxxxxxxxxx 
Yyyyyyyyyyyyy 
 
Or, call 
 
XXX-YYY-ZZZ 
 
For questions regarding this FCC declaration, contact: 
 
Philips Electronics NA 
Xxxxxxxxxxxxx 
Yyyyyyyyyyyyy 
Zzzzzzzzzzzzzzzz 
 
Or, call 
 
XXX-YYY-ZZZ 
 
To identify this product, refer to the Part, Series, or Model number found on the product. 
 

6.2.1 Canadian Notice 
 
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations. 
 

6.2.2 Avis Canadien 
 
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel 
brouilleur du Canada. 
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6.2.3 Japanese Notice 

 

6.3 Wireless Notices 
 
In some situations or environments, the use of wireless devices may be restricted. Such 
restrictions may apply aboard airplanes, in hospitals, near explosives, in hazardous locations, etc. 
If you are uncertain of the policy that applies to the use of this device, please ask for 
authorization to use it prior to turning it on. 

6.3.1 Canadian Regulatory Wireless Notice 
 
Operation is subject to the following two conditions:  
(1) this device may not cause interference, and  
(2) this device must accept any interference, including interference that may cause undesired 

operation of the device. 
 
To prevent radio interference to the licensed service, this device is intended to be operated 
indoors and away from windows to provide maximum shielding. Equipment (or its transmit 
antenna) that is installed outdoors is subject to licensing.  

6.3.2 European Union Notice 
 

Products bearing the CE marking comply with the R&TTE Directive (1999/5/EC), EMC 
Directive (89/336/EEC) and the Low Voltage Directive (73/23/EEC) issued by the Commission 
of the European Community. Compliance with these directives implies conformity to the 
following European Norms (in parentheses are the equivalent international standards and 
regulations):  
 
§ EN 55022 (CISPR 22) – Electromagnetic Interference 
§ EN55024 (IEC61000-4-2, 3, 4, 5, 6, 8, 11) – Electromagnetic Immunity 
§ EN61000-3-3 (IEC61000-3-3) – Power Line Flicker  
§ EN 60950 (IEC 60950) – Product Safety 
§ ETS 300 328 – Technical requirements for radio equipment 
§ ETS 300 826 – General EMC requirements for radio equipment 
 
This product may be used in all EU and EFTA countries. 
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6.3.3 Japanese Notice 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


